
Excire Foto 2027 Quickstart (EN)



Versioninfo

This documentation is based on Excire Foto 2027 Version 5.x.x



What is Excire Foto? - The highlights

Excire Foto is the most innovative AI-based software for perfect photo management on
Windows or macOS. Automatic image analysis and tagging, numerous intelligent search
functions and the integrated duplicate finder help the user to keep order and find the
photos you are looking for. Excire Foto is not only fun to use, it saves a lot of time that
can be better spent on the creative side of photography.

Excire Foto 2027 introduces a range of exciting new features that make photo
management faster, smarter, and more intuitive than ever. The new intelligent text
recognition automatically detects visible text in photos – from street signs and race
numbers to business names and car stickers – making it instantly searchable. The new
world map view lets you explore your photos geographically, finding images directly by
their location. A redesigned filter bar and timeline provide a significantly more efficient
workflow. Additionally, the new quick photo selection in overview mode brings back the
feel of the classic analog light table, while the new 3×3 grid and peaking mode allow for
precise assessment of image composition and sharpness at a glance. On top of that,
Excire Foto 2027 includes many further innovations and improvements that enhance the
entire photo management workflow.



Installing the software

Once you have downloaded our software, you can install Excire Foto on your computer.

Under macOS, unzip the corresponding ZIP file (double-click) and mount the
corresponding disk image (double-click the dmg file).

Now all you have to do is start our installation program, which will guide you through the
installation step by step.

Windows users simply start the downloaded executable file (*.exe) and follow the
installation instructions.



Product activation

After purchasing and installing Excire Foto 2027, the program must be activated once in
the user account.

The following steps are therefore necessary:

1. if not already available, an Excire user account must be created and the user must be
logged in there. This is done via the program interface via the menu Excire Photo ->
Settings in the "License" tab.

There is a step-by-step tutorial on how to do this
here: https://support.excire.com/portal/en/kb/articles/how-do-i-create-an-excire-user-
account-to-activate-the-software

2. After logging in, the activation code from the purchase confirmation can be entered.

https://support.excire.com/portal/en/kb/articles/how-do-i-create-an-excire-user-account-to-activate-the-software
https://support.excire.com/portal/en/kb/articles/how-do-i-create-an-excire-user-account-to-activate-the-software


That's already it. The program is now activated and the activation code will no longer be
required.

You will find detailed instructions with pictures on how to create a user account in your
purchase confirmation.

Further information can also be found in our Help Center under "Account management

and activation".

https://support.excire.com/portal/en/kb/excire/user-account-activation
https://support.excire.com/portal/en/kb/excire/user-account-activation


Note on upgrading from older Excire Foto versions

If you have previously used Excire Foto in an older version, the existing database will be
updated the first time you launch Excire Foto 2027.

We recommend that you back up the database beforehand. Once this update is
complete, you will no longer be able to revert to a previous version of Excire Foto using
this database.

To use the new feature for searching for text in photos, your existing photos must be
reanalyzed. During the update, you can choose whether to perform this analysis
immediately.

Manually assigned keywords will not be changed.



User interface overview

The user interface is divided into a left column, which contains the folder navigation and
can display search results and collections. The timeline and the people directory are
also located in the left column, as is the tab for accessing selection projects (often
referred to as “culling”).

To the right of this is the grid view with thumbnails of the photos. Double-clicking on a
photo displays it in a larger preview (optionally also in a 1:1 preview at the image’s
original size).

In the right-hand column, you can choose from various data views labeled General,
Metadata, Faces, and AI & Keywords. These views display detailed information about the
selected photo, such as the histogram, technical shooting data, metadata, and keywords
—both those assigned by AI and those added manually.

When the "AI & Keywords" view is active, the keyword hierarchies assigned by Excire
Foto are also displayed in the right-hand column. However, user-defined keywords can
also be organized hierarchically. By clicking on a keyword, you can navigate directly to
the photos with corresponding content.

The filter bar is located at the top between the menu and the photo grid. A dropdown
menu allows you to select the criteria by which to filter—including image content, text in
photos, metadata, and people. A text input field next to it allows you to enter the search
term directly. Additional filter options such as file format, star rating, color tags, and
flags are also available in the filter bar.

The bottom bar contains buttons for switching between gallery view, world map view,
and overview mode for quick photo selection. You can also set the display sorting here.
The status bar shows the number of photos in the current view as well as the number of
selected photos.

Excire Foto’s various search functions can be accessed via the buttons in the top-right
corner of the window.





Create the first and additional databases

During installation, Excire Foto asks for a directory in which to create the default
database.

In fact, this directory will later store not only the database file, but also other data such
as thumbnails, preview images and the program cache (temporary storage). These data
can consume some disk space over time, so it makes sense to make sure that there is
enough free space on the selected hard disk.

The Excire databases require about 250 MB of hard disk space for 100,000 photos. The
preview memory is then about 25 GB at the highest quality, and when a preview is
generated for each photo.

Moving the default database to another hard drive

It is also possible to manually move the database to another hard disk afterwards. To do
this, Excire Foto must be closed and the selected directory with the required files and
subdirectories must be moved to the new location. The next time Excire Foto is started,
it will detect the missing database and ask where to create a new default database. If
you select the new location of the folder here, the database will be opened from this
location from now on.

These files and folders must be moved in the process:

1to1.exfoto 
previews.exfoto
thumbnails.exfoto
excire_foto.local.db 
excire_foto.local.db-shm (if existing)
excire_foto.local.db-wal (if existing)
backend.db 
backend.db-shm (if existing)
backend.db-wal (if existing)

You can find these files and folders under:
Windows (10 and 11): 
"%APPDATA%\Roaming\Excire Foto"

Mac OS X: 
"/Users/<username>/Library/Application Support/excire-foto"



Additional databases

For some photographers it may be useful not to manage all photos in a single database.
They can create an additional database in the selected directory via the menu command
"File -> Choose folder for new database". 



Via "File -> Open database folder" it is then possible to switch between the existing
databases. To do this, the program is automatically closed briefly and reopened with the
selected database.





Important initial settings

Before the first photos are read into the database, it should be ensured that the program
settings correspond to the user's intentions. While it is possible to change the settings
at any time, in some cases this can result in the need to re-analyze directories, which
can add additional time that may be unnecessary if the possible settings are considered
in advance.

While the default settings meet the needs of most users, Excire Foto is used by very
different types of photographers, so we have provided additional flexibility via the
settings.

In the Excire Foto -> Preferences menu, various settings can be made via the different
tabs.

Before importing photos for the first time, these settings are important:

In the "Add" tab, you will find the option to enable reading of PSD files created with
Adobe Photoshop. The default setting is "off", as this slows down the process of reading
in folders.



Under "Previews" there is an option to set the quality of compression for the preview
images. The size of the previews that Excire Foto generates is always 1280x720 pixels.
If this resolution is not sufficient, the 1:1 preview can be activated. This option is always
available in the preview, but is usually generated only after confirming a demand,
because 1:1 previews consume significantly more disk space on the hard disk where the
Excire Foto database is stored.

This request can be disabled in the settings. In addition, the 1:1 preview image can then
be used as the default preview image. However, this may delay the quick browsing of
photos a bit, since the larger file has longer loading times than the smaller preview
version of the photo.



In the "Metadata" tab, you can set whether Excire Foto should always save the metadata
in sidecar files in XMP format when the "Save metadata" function is selected from the
menu. This is a special case, as normally XMP files are only used for raw formats; for
JPG and TIF files the metadata will be saved directly in the image file. Users who want to
exchange metadata between Excire Foto and the Capture One image editor must enable
the "Always use sidecar files" option, otherwise Capture One will not read the metadata.

If you want your existing keywords to be imported into Excire Foto, make sure to activate
the option "Load keywords from photos".

Setting "Append metadata array content"

This setting ensures that keywords are not overwritten but added (appended to the list)
when saving. Existing keywords are not removed. The default setting is "enabled" so that
existing keywords from other applications are not accidentally overwritten. In some
cases, it may be useful to disable this setting, for example, if keywords have been
removed in Excire Foto and you now want to remove them from the saved file as well.





Adding photos in Excire Foto

After the most important basic settings have been made, the actual construction of the
photo archive begins by adding photo folders from the hard disk in Excire Foto to the
database.

To do this, click on the "+Add" button in the left column of the screen and select a
directory. This can be directly added to the database with all its subfolders. The photos
are not only added, but also analyzed and automatically tagged with the help of artificial
intelligence (AI).



This process may take some time, but only once. For large photo collections, it can
make sense to let the process run overnight.

We also recommend running a test with a smaller set of photos first to get a feel for how
long it takes to load and analyze the photos. This is highly dependent on the speed of
the system used consisting of computer hardware and hard drives, as well as their
connection. Photos can also be added from external hard drives or data servers on the



network (NAS systems).

When adding photos to the database, the original files remain unchanged in their
location. 

Excire Foto creates reduced preview files in the database, so that the photo archive can
be searched and displayed even when external hard drives are not currently connected.

The progress of the import process is indicated by a progress bar. If you click on this
bar, more details are displayed, and it is possible to cancel the process prematurely.
Data that has already been collected is retained, so that you can continue adding and
analyzing it later.



Resuming the import after an interruption

To continue the process after an interruption, right-click on a folder name and first select
"Analyze" to finish analyzing the photos that have already been added.

Then select "Synchronize" for the folder to add and analyze any missing photos.







Synchronizing - adding new photos to an existing folder

If you save new photos in an existing folder, it must be synchronized in Excire Foto in
order to include and analyze the new photos.

To do this, right-click on the name of the folder in the folder navigation and select the
"Synchronize" command.





A dialog box will now appear in which you can set whether subfolders should also be
searched, whether any existing keywords should be read from the files or whether an
IPTC profile should be assigned.

Afterwards a security question appears, which should be read carefully, before you
answer it with No or Yes!

The question is whether you want to remove unavailable folders and photos from the
Excire Foto database during synchronization.

This is useful if the contents of the folders have changed due to moving and deleting
photos. These will then be removed from the original folder in Excire Foto, as they are no
longer accessible there.

However, if you are synchronizing a folder on an external hard drive that is not currently
connected, clicking "Yes" would mean that all folders on that hard drive would be
removed from the database!



Copying photos from a memory card

To copy photos from a memory card to your computer and simultaneously add them to
the Excire Foto database, please follow these steps:

Connect the memory card or camera to your computer.
In Excire Foto, select the "Copy and Add" function from the file menu.
Choose the memory card as the source and select a target folder on your hard
drive, then start the copying process.

Optionally, you can rename the photos during this process if you have set up a renaming
profile beforehand. For more information on how to use renaming profiles, please refer
to the relevant section of this documentation.

You can also choose whether to include subfolders from the memory card. This is
recommended, as many cameras create a directory structure with subfolders.

If you do not want to analyze the photos immediately, you can do so later in a separate
step. The same applies to generating previews. However, we recommend most users
leave the default settings as they are.

If you are working with IPTC profiles in Excire Foto, you can use them to automatically fill
in specific metadata, such as the photographer’s name and contact information.





Image preview and comparison view

Double-clicking on a photo opens the single preview view. This view displays the
enlarged photo along with various details in the right and left columns of the screen.

The left column shows general information about the file, while the content of the right
column changes depending on the selected information icon.

The following options are available:

Metadata
Faces
AI & Keywords

Under Metadata, there are several data views to choose from.

Additional details can be found in the respective sections of this documentation.



Quick Navigation
You can quickly navigate between photos using the left and right arrow keys.

Comparison View
To directly compare two photos, you can switch to the comparison view. This allows you
to evaluate and compare photos side by side. The photo in the right panel (candidate)
can be promoted to a new favorite using the button below the images, allowing you to
continue the selection process until the best photo is chosen.

By default, both images in the comparison view are zoomed and panned in sync.
Clicking the button with the chain link icon above the images unlocks the two views,
allowing each image to be zoomed and panned independently. This is particularly
helpful when you want to compare details in different parts of the two photos.



Quick photo selection in survey view

Survey view allows for quick and intuitive image selection directly from the gallery—similar to

working on an analog light table.

To launch the survey view, first select the desired photos in the gallery using the mouse and

the Shift or Ctrl key. Then click the "Survey View" button in the bottom bar.

The selected photos are now displayed side by side in full-screen mode. When you hover

your mouse over an image, additional options appear:

Click the X in the top-right corner of the image to remove a photo from the overview. This

allows you to gradually narrow down your selection until only the best image remains.

Using the icons in the bottom-left corner of the image, you can assign a star rating or a flag to

a photo without having to leave the view.

Press the ESC key to exit survey mode and return to the normal gallery view.





3×3 Grid & Peaking Mask

In single-image view, which you can open by double-clicking on a photo, two helpful tools

are available for precisely assessing sharpness and image composition.

Peaking Mask
Click the button with the star icon in the top bar to activate the Peaking Mask. Sharp edges in

the image are then highlighted in color—red by default. You can customize the color in the

program settings to suit your preferences.

Use the slider next to the button to fine-tune the threshold for sharpness detection: A lower

value highlights more edges, while a higher value limits the display to the sharpest areas of

the image.



3×3 Grid
Click the button with the diamond icon in the top bar to display a 3×3 grid over the image.
This helps you assess the image composition at a glance using classic design rules, such as
the rule of thirds.

Both features can be enabled independently of each other and can also be used in

combination.





Image selection with culling projects

Culling projects support you in reviewing your photos in high resolution, zooming in on
faces for a quick assessment, automatically grouping your photos according to various
criteria or even selecting the best shots from image series of people or scenes with the
help of AI.

Image collections of up to 10,000 images, for example the photo folders from a trip or a
photo shoot, can be transferred to a culling project and analyzed there.



Creating and editing a culling profile

In a culling project, a culling profile is applied to the selected photos within the project.

The culling profile defines how the photos are grouped and, if applicable, automatically
rated.

Excire Foto comes with several predefined culling profiles, which cannot be modified.
However, you can save a predefined profile under a new name and then edit it as your
own custom profile.

Culling profiles can be managed through the menu under File -> Culling Profiles.

Profiles can also be exported to your hard drive and imported later, for example, to
create a backup or transfer the profile to another user's computer.

The following settings can be adjusted via the different tabs in a profile:

Rejections:

Reset existing rejection flags initially
Reject blurry photos
Reject overexposed and underexposed photos
Reject photos in which all eyes are closed



Rejected photos are marked with a rejection flag and assigned to the trash bin in the
culling project. They are not automatically deleted.

Grouping:

Group by people: Photos of the same person are grouped together. The similarity
threshold can be adjusted if too many or too few groups are created.
Group by content: Photos are grouped based on predefined keywords. Any
desired keywords can be selected in the profile for grouping purposes.
Group by visual similarity: Photos are grouped by the AI based on similar visuals.
Similarity can be determined by content or color, with a slider available to define
the similarity threshold.
Group by capture date: Photos are grouped by their chronological distribution.
Various time intervals can be selected for grouping.

Selection marker:

Reset selection marker initially
Use the following marker to select a photo: options include acceptance flags, star
ratings, or color markers.

Smart Selection:
If smart selection is activated, you need to define which groupings are relevant to unlock
further selection options.



Based on the specified criteria, the predefined number of photos will automatically be
added to the selection folder of the culling project.
Note: Changes to a culling profile will only take effect for new culling projects.



Starting a culling project

There are three ways to start a culling project:

1. By clicking the plus button in the Culling Projects tab. You can then select folders
or collections to include in the project.

2. By right-clicking on an existing folder in Excire Foto and selecting "Start culling
project for folder(s)."

3. By enabling the "Start culling project" option when using the "Copy and Add"
function.

Before starting the culling project, you must select a culling profile to apply. Once
selected, click "Start" to create the project and initiate the automatic grouping and
selection process based on the profile's settings.

When you start a culling project using the plus button, the photos will be organized into
groups according to the selected culling profile.

Within the project, groups can be merged or removed as needed. Similarly, individual
photos can be removed from groups if they are not relevant.

Culling Process

Choosing the best photos is a personal process, and the grouping feature helps
maintain a structured approach.

You can navigate between groups using the navigation buttons above the image display
or the corresponding keyboard shortcuts.



Using the marking tool, you can highlight accepted and rejected photos. Accepted
photos are outlined in green, while rejected photos are outlined in red.

Advanced Sorting Options

To help identify the best photos, advanced sorting criteria can be applied within the
culling project. By selecting "Additional Attributes" in the sort menu, you can enable
criteria such as Aesthetics, Sharpness, Face sharpness, Eye sharpness, Eyes open, and
Smile.



Completing the Culling Project

Any flags, star ratings, or color labels assigned during the culling project will remain
after the project is completed. This allows you to easily find your selected photos within
the folder or prepare them for editing in another application.

Additionally, selected photos can be converted into a new collection or added to an
existing one by right-clicking on the "Selection" folder.

Once the culling project is no longer needed, it can be removed from the list by right-
clicking and selecting the appropriate option.



Usage of favorites in a culling project

Another special feature in culling projects is the use of favorites.

In the display for a sub-collection of the culling project (people, content, similarity, etc.),
the photos are combined into groups. You can mark one or more groups that are
particularly interesting for the selection as favorites by right-clicking on them. A heart
symbol will appear in the display to indicate this.

You can now select "Favorites" as a sort criterion in the sorting so that the favorites
appear at the top of the display.

The favorites also play a special role in the smart selection.

If you have marked one or more groups as favorites and then start the smart selection
again, the selection of photos is limited to the groups that are marked as favorites. The
remaining groups in the respective sub-collection are not taken into account.

If no favorite is marked in a sub-collection, all groups are taken into account for the
smart selection as usual.



Preview for videos

Videos are also added to the Excire Foto database and displayed in the gallery.

Keywords are automatically assigned based on a still frame from the video, allowing the
video to be found using the keyword search.

A double-click opens the video preview, where the video can be played. A full-screen
preview is also available.

By right-clicking on "Open with...," you can launch external video programs to play or edit
the video.

In the right-hand column, technical information about the video, such as resolution,
codec, and bitrate, is displayed.



Rate faces and assign names

To assign a name to a face in one or more photos, first select the "Faces" display in the
right-hand panel.

You can assign a name in the gallery view for one or multiple selected photos or in the
single photo preview.

Excire Foto will display all the detected faces from the selected photo(s) in a list.

If the "Zoom Faces in Gallery" option is active, you can enter a name in the associated
text field ("Who is this?") or choose an existing name from the list.

The right-hand panel offers several options for how faces are displayed.

Gallery View Display Options

Zoom Faces: Enlarges the face in the photo to make identification easier. If there
are multiple faces in a photo, zooming is disabled.
Zoom with Mouse Pointer: Enlarges the face only when the mouse pointer hovers
over the photo.

Preview Mode Display Options (Single Image View):

Highlight Faces: Adds a rectangular marker around each face. Moving the mouse
over the marker reveals additional information about the face.
Adjust Faces: Enlarges a face to fill the display when clicked in the right-hand
panel. By holding the Option key and using the left or right arrow keys, you can
switch between multiple faces in a single photo—perfect for evaluating group
shots.



Symbol Meanings Under the Face Display:



1:1: Indicates the face was cropped from the original 1:1 preview.
Arrow Down (or Up): The image has been resized smaller or larger to fit the
display frame.
Focus Indicator Colors:

Green: The face is sharp and in focus.
Yellow: The face might be slightly blurry.
Red: The face is blurry and out of focus.

The focus indicator colors are also reflected in the borders around the faces when the
"Highlight Faces" option is active.

If a face is not recognized automatically

In some cases, the AI may not automatically recognize a face and mark it with a frame.
For example, if a face is only visible from the side, partially obscured, or very small in the
photo.

In these cases, it is possible to manually draw a frame around the face with the mouse
and assign a name.



To do this, click on the "face with the plus"-symbol and then drag a frame over the photo
with the mouse.



View or search photos of someone with an assigned name

The left column provides options to display a timeline and a people directory.

In the people directory, all names that have been assigned so far are displayed in an
alphabetical list. Clicking on a name shows all photos of that person in the photo display
where the name has already been assigned.

You can also search for photos featuring a combination of specific people. To do this,
use the keyword search by clicking the search button in the upper-right corner of the
program. In the search interface, all known person names are also listed, but here you
can include or exclude names using the plus (+) or minus (-) symbols. For example, you
can search for photos that feature Mary AND (+) Jon but NOT Paul (-).





Assign keywords automatically and manually

As photos are added, Excire Foto automatically analyzes them and, with the help of
artificial intelligence, assigns appropriate keywords to the photo in terms of content and
photographic criteria.

For example, the photo of a dog can be automatically associated with the keywords
"pet", "dog", "mammal" and "animal". But also with "bright" and "contrasty" from the
category of photography keywords.

The user has no influence on the initial assignment of the keywords by the artificial
intelligence. Subsequently, however, the keywords can be supplemented by own
keywords and unwanted or inappropriate keywords can be removed from the photo.

To do this, select one or more images in the image overview and then edit the keyword
field in the right column.

Clicking the small cross next to a keyword removes it from the photo.

New keywords can be assigned by entering a keyword in the field above the keywords.
Keywords that have already been created are suggested for selection during the typing
process, so that similar keywords are not created unintentionally. By clicking the plus
symbol, a new, user-defined keyword is created.

Keywords that are already included in the AI keyword hierarchy of Excire Foto are
displayed with a blue frame, user-defined keywords are displayed with a gray frame.

Behind keywords assigned by the AI, a number is displayed (0.01 - 0.99) indicating which
certainty (level of probability) the AI assumes for this keyword. 



Keyword confirmation

You can confirm AI keywords by clicking the checkmark in front of the keyword. This
causes these keywords to be treated as manually assigned keywords and the photos to
appear at the front of the results display when searching for these keywords.

Alternatively, you can select the keywords of the photo and drag and drop them onto the
photo to confirm the keywords.

Managing Keywords

It is possible to select multiple keywords assigned to the photo, regardless of whether
they are user-defined or AI-suggested.

Here are two ways to select multiple keywords:

Option 1: Hold down the Control (Ctrl) key and click on the desired keywords with
the left mouse button.
Option 2: Hold down the Shift key and use a left-click to set a start and end point.
This will select all keywords between these points, including the start and end
points.

Assigning Multiple Keywords:

You can now drag and drop the selected keywords onto other photos. Alternatively, you
can copy the keywords to the system clipboard and paste them elsewhere.

Merging keywords

When more than one photo is selected, it is possible to merge all the keywords of the
selected photos. This means that each of the selected photos will end up with the
combined keywords of all the photos.

Example:

Photo A has the keyword "House."

Photo B has the keyword "Roof."

After merging the keywords, both photos will have the keywords "House" and "Roof."



Assign folder name as keyword

By right-clicking on the corresponding command for a folder, you can apply the folder
name as a keyword to all photos contained in the folder. This can be done either for the
selected folder or, additionally, for the folder’s subfolders as well. This is useful if the
photos have been organized into folders with descriptive names that you now want to
convert into keywords for better management.

Hide Irrelevant Keywords

Excire Foto automatically assigns keywords from an extensive AI keyword hierarchy. Not
all of these keywords are equally relevant to every photographer. Using the menu
command "File -> Hidden Keywords," you can permanently hide specific keywords from
view.



In the dialog, the keywords of the Excire hierarchy are displayed in a multi-column list.
Clicking the crossed-out eye icon next to a keyword hides it; clicking the normal eye icon
shows it again. Hidden keywords still appear in the list but will no longer be displayed or
assigned to photos in the future.

Using the "Hide Sub-Keywords" option in the right column, all sub-keywords are
automatically hidden when a parent keyword is hidden. The right column also displays
an overview of all currently hidden keywords, which can be individually removed there.

A quick search at the top of the dialog makes it easier to find specific keywords in the
list.

Hidden keywords are no longer displayed in the program and are not saved when saving
metadata or exporting.



Creating and using a keyword hierarchy

In the right column under "AI & Keywords", Excire's own keyword hierarchy and the
hierarchy of user-defined keywords are displayed one below the other and can be
expanded and collapsed.

In the Excire Foto keyword hierarchy, only the keywords that have already been assigned
to one or more photos during the analysis are displayed. It is not a complete list of all
keywords available in Excire Foto.

The Excire Foto AI keyword hierarchy cannot be modified by the user.

The situation is different with the user-defined keyword hierarchy. Here, any number of
keywords can be added and created in the form of a custom hierarchy. 

Important: A user-defined keyword hierarchy must be created in advance before the
keywords are assigned to photos. Once keywords have been created, they cannot be
subsequently arranged in a hierarchy.

To add a keyword to the user-defined hierarchy, right-click on an existing keyword and
select "Create keyword". The new keyword will then be placed under the selected



keyword in the hierarchy.



View and edit photo metadata

In the right-hand panel (when the Metadata tab is active), the photo's metadata is
displayed and can be edited by clicking the pencil icon.



This opens the dialog for editing the metadata, where the fields for contact, content,
shot and copyright can be filled in. This can also be done using a pre-defined IPTC
profile that can be assigned to the photo.

The metadata view is divided into EXIF data and IPTC data categories. You can find the
toggle switch in the left column of the metadata window.

The display and maintenance of EXIF data is again divided into different views: By
clicking the corresponding tab above the display, you can switch between General and
GPS Data.



EXIF data

EXIF data (Exchangeable Image File Format) contains important technical information
that is automatically recorded by the camera when a photo is taken. This data can help
to understand the circumstances under which the photo was taken.

The EXIF data display contains technical data about the shot, such as the camera
model, exposure time, aperture and the date the photo was taken.

With the exception of the shooting date (at the bottom), the EXIF data cannot be
changed.



Change Capture Date

The recording date can be found in a separate tab on the far right of the EXIF data
display in the metadata editor.

There you can set a recording time consisting of the date and time for one or more
photos.

There are three options for this:

1. Set the recording date to a fixed value: Here you can specify a new recording date
and time for the selected photo(s).

2. Change by the hour: The original recording date serves as the basis, and the
corresponding number of hours is added or subtracted (if negative).

3. Set the recording date to the file creation date: Sets the recording date to the date
on which the file was created.

 

Then click Save to apply the changes. This allows you to change the recording date and
time for several selected photos at once. To do this, check the box under "Apply to all"
before saving.



GPS data

In the GPS tab, you can display or edit the GPS coordinates for a photo.

The GPS coordinates can be entered in a text field with latitude and longitude.
Alternatively, it is also possible to select the location in a map view. 

You can move the map section as you like and zoom in or out. As soon as you click on a
location, the coordinates are automatically transferred to the text field.

The dialog must be confirmed with Save to save the changed coordinates.

GPS data can be used for GPS search in Excire Foto.



Transfer GPS data from one photo to another

If you have a photo that already contains the GPS data and you want to transfer it to one
or more other photos, there is an easier way than using the metadata editor.

To do this, select the photo with the GPS data and click on the "Copy GPS metadata"
button in the right column under Metadata. Then select all photos that should get the
same GPS coordinates and click on the button "Paste GPS Metadata".









IPTC data

In the IPTC (International Press Telecommunications Council) category, you can add
detailed metadata to an image that is essential for identification, organization, and
rights management. These details are particularly important for professional
photographers, editors, and image agencies, as they ensure clear attribution and legal
compliance.



Using IPTC profiles

The File - IPTC Profile Manager command allows you to create and modify IPTC profiles,
which can then be assigned to one or more photos. 

This is possible in two ways: 

1. when editing the metadata

2. directly when adding the photos when importing a new folder or synchronizing.



If you use IPTC profiles to fill the metadata, it is easier to update the data later by simply
changing the IPTC profile. All changes are automatically applied to the images that have
the corresponding IPTC profile assigned.



Save keywords and metadata

To permanently save edited metadata and keywords to the image files or associated XMP

sidecar files, select the "Store Metadata" command from the menu. This is particularly

important if you want the data to be visible in other programs such as Adobe Lightroom or

Capture One.

When you execute the command, a dialog opens where you can specify which types of

keywords should be saved:

Include Excire keywords: Use a dropdown menu to select whether all AI keywords, only

manually confirmed ones, or no AI keywords should be saved.

Include custom keywords: Determines whether manually created keywords are written to

the file.

Include names assigned to face regions: Determines whether the names assigned to faces

are also saved in the metadata.

Using the "Do not show this dialog again" option, you can apply the current settings as the

default and skip the dialog in the future.

Note: The format used for saving metadata (directly in the image file or as an XMP sidecar

file) can be specified in the program settings under the "Metadata" tab.



Narrow down the current view by using the filter bar

Above the gallery view is the filter bar, which allows you to narrow down the number of
photos displayed using various criteria. This filtering always applies to the photos
currently displayed, which were selected by choosing one or more folders in the folder
navigation on the left-hand side or by clicking "All Photos" under Database.

If the filter options are not visible, you can expand the filter toolbar by clicking the funnel
icon.

Quick filter with text input

Directly above the filter bar is a combined search and filter field. Use the dropdown
menu on the left to select the desired search criterion—for example, image content, text
in photos, or metadata. Enter the search term in the text input field next to it and confirm
by pressing the Enter key.

Timeline chart

Click the chart button to the right of the funnel icon to display the timeline chart. It
shows the distribution of photos over the years as a bar chart. Clicking a bar displays
only the photos from the corresponding time period. You can select multiple bars at
once by holding down the Ctrl key. You can also zoom in and out of the chart to view
individual years or larger time periods in more detail.

Additional filter options

Three buttons allow you to enable or disable filters for non-RAW formats, RAW formats,
and video files.

Under the "Attributes" section, you can filter photos by various properties such as
ratings, dimensions, orientation, as well as photos with errors or missing metadata.

You can also filter by Metadata such as camera, aperture, shutter speed, or focal length.
The capture date can also be narrowed down, e.g., by year, month, or a specific day.
Using the dropdown menu for People, you can select names that have been previously
assigned to the photos.

You can sort the display using the selection button in the bottom bar by filename, date
taken, star rating, recently added images, or aesthetic rating, either in ascending or
descending order. 

Note: You can edit metadata fields such as title, description, category, city of origin, or
country of origin in the metadata editor for the photos. The city and country of origin are
text fields that are not determined by GPS coordinates.





Find by text prompt

You can access the text search by clicking the corresponding button in the upper-right
corner of the window. This allows you to search for photos by entering any text—
regardless of manually assigned keywords.

In the text input field, enter your search term or a description of the image, such as “A
lovely afternoon in the garden” or “Romantic atmosphere by the lake.” Use the switch to
the right of the input field to toggle between German (DE) and English (EN).

Under “Search Settings”, you can specify what to search for:

Photo Content: The AI searches the photos based on their visual content, focusing
solely on how one would describe an image.

Text in photos: The AI searches for visible text contained in the photo. 

Both options can be enabled simultaneously.

Under “Find options”, you can set additional parameters:

Distance limit (for image content only): Determines how strict or loose the match with
the search term should be.

Max. Number of Results: Limits the number of search results displayed.

Overwrite Results: Determines whether a new search result replaces or adds to the
previous one.

Search in: Choose between the entire database, the current view, or specific folders and
collections.

You can then refine and narrow down the search results using additional search
functions, such as keyword search.

Important note: You cannot search for file names or folder names using this function.
Use the text field in the filter bar for this purpose (see the section “Narrowing down
photos using the filter bar”).





Search for text in photos

Excire Foto 2027 automatically recognizes visible text in photos — from street signs to

business names and labels. 

This text can be searched in two ways.

1. Filtering in the gallery view

In the filter bar above the gallery, you can select the "Text in Photos" option from the

dropdown menu and enter a search term. The gallery view will then immediately be

narrowed down to the photos that contain the entered text.

2. Search via “Find by Text Entry”

Use the corresponding button in the top-right corner of the window or the menu to open the

“Find by Text Entry” search box. Here, you can choose between two search options:

Image Content – searches based on an AI analysis of the image content (as before)

Text in Photos – searches for text actually visible in the photo using its own text recognition

The search results are displayed separately in both categories. A photo may appear in both

categories at the same time.

Notes on text search

The text you enter must appear exactly as entered in the photo. Searches using placeholders

or multiple words that do not appear consecutively are not possible. The language setting

(DE/EN) has no effect when searching for text in photos.

In single-image view, the found text is highlighted in color within the photo.

Search field:



Search results:

Single image view:





Find Duplicates

With the help of the duplicate finder it is possible to find photos that are duplicate or
multiple in the archive and mark them for deletion if desired.

For all dialog elements there are tooltips that appear as soon as you move the mouse
pointer over the corresponding element. This is important because they often contain
important explanations.

We distinguish three types of duplicates in the Duplicate Finder:

a) Exact duplicates: These are photos or files that are binary identical. Since this
requires checking each file again, this duplicate search takes longer. It also requires
access to the original files. This means that external hard drives must be connected in
order to find exact duplicates on them.

b) Near duplicates: These are photos that are visually similar. The degree of similarity
can be adjusted by a slider. The stricter the setting, the more you will find almost exact
duplicates. Here you can optionally choose between a faster or a more accurate search
algorithm. 

Variant b) is therefore our standard recommendation for duplicate search.

c) Sequences or bursts: These are photos of a sequence whose shooting date may
differ only by a certain duration, which can be set. This function is also useful when
photos differ because they have been edited or developed differently. Since the capture
date is identical for these photos, you can thus find different variants of a photo
(different white balance than the raw, B/W, etc.).







Delete all duplicates except one

Many users of Excire Foto want to keep only one of the found duplicates. However,
finding the "original" is not always easy with digital duplicates.

Caution: The display always shows all images in a duplicate group, so you
should not delete all of them.

There is also a difference between "Exact Duplicates" and "Near Duplicates." Both are
search options in the duplicate search.

For "Exact duplicates", there is no automatic way for the program to decide which one to
keep. However, it is possible to use parts of the file name or the directory as selection
criteria.

The search by source and target directories is also useful here.

For "Near Duplicates," there are additional options to let the program make a
preselection, such as keeping the photo with the highest resolution, a RAW file, or the
image with the highest rating.

These settings can be found in the Flag Assistant. In the case of exact duplicates, the
simplified settings are grayed out. Please use the advanced settings further down in the
selection window.

Select the first photo
This function can simplify the selection by keeping only the first photo of a duplicate
group.
Here's how it works:

1. You can find this option above the gallery under "Select First." 

2. If you want to delete all photos except the first one, you can select all other
photos under the "Edit" tab -> "Invert Selection" (or with the shortcut Ctrl + I). 

3. Then you can delete them by right-clicking on one of the selected photos and
choosing "Remove Photo(s)." Alternatively, you can flag them for rejection and
delete the photos later.





Edit search result with the flagging assistant

The duplicates found can be edited using the flag assistant, which helps to mark
duplicates that are no longer needed with a rejection flag (deletion flag) and then delete
the photos permanently. Alternatively, the "Accepted" flag is used to positively mark
photos and then delete the unmarked duplicates.

By default, the settings that are easiest to use are displayed at the top of the dialog.

These include:

Reject all photos except RAW - (sets a rejection marker for all other formats
except RAW).
Reject all JPGs whose shortest side is smaller than (value can be set in pixels) -
sets a reject marker for resized JPGs (for example, photos used for the web or
email)
Accept all RAW/JPG pairs (sets an "Accepted" flag instead of a reject marker)
Accept the JPG with the highest resolution (can also accept RAW files)

As an alternative to the default settings, the advanced settings can also be used to have
more detailed selection options. Here you can first determine whether the Accept flag or
the Reject flag should be used.

Then settings for non-RAW formats (JPG, PNG, etc...) can be made separately from the
settings for RAW formats.

Selection criteria can be size or age of the file or also the rating with star markers. In
case of exact duplicates, a distinction based on parts of the file name with wildcards
can also be selected (for example, "*web.*").

Before executing the automatic flag settings, it is also possible to select whether
existing flags should be overwritten or retained.

Important:

The flag assistant does not automatically delete photos, but only marks them with
appropriate flags, which can then be used to select for the deletion process.



Advanced settings for Near-Duplicates:





Advanced settings for Exact Duplicates:





Duplicate Statistics 

As an alternative to the Flag Assistant, you can also use the "Duplicate Statistics" to
manage flags. This option can be found in the duplicate search results display above the
gallery. In the "Duplicate Statistics", you get a comprehensive overview of which folders
contain duplicates, and you can directly assign a flag to all images in a folder if needed.



Find people

With the help of the Find People function you can find all the photos of a certain person
in the database.

To start the search, select a photo in the library that contains the person you are looking
for.

Then click the “Find people" button in the upper right corner of the search bar.

The search dialog opens, in which the marked photo is displayed and the face is framed
with a box. If there are several faces, click on the one of the person(s) you are looking
for to select it. It is also possible to search for photos with more than one person.

The filter options can be used to narrow down the search, for example to photos in
which the person you are looking for is smiling or has their eyes open.

In addition, keywords can be specified to further refine the search.

Search options can be specified in the lower section of the search dialog. These options
concern the degree of similarity with the searched person, the maximum number of
search results (from 10 to a maximum of 50,000) and whether the search should be
performed in the entire database, only in the currently displayed photos or in specific
folders or collections.

Find people results can then be transferred to a collection and tagged with the person's
name. Or you can assign a keyword with the person's name to the photos so that you
can find them later using a simple keyword search.





Find by keyword, content and people

The keyword search can be accessed via the "find by keyword" button in the top-right
corner and allows you to select a combination of keywords that must match the photos
you're looking for.

Both automatically assigned keywords and user-defined keywords are available for
selection. If names have been assigned to faces, those names from the people list can
also be used in the search.

Example: You can search for photos of "Denise" with a "bicycle" by selecting the
corresponding keywords.

There is also the option to search using either "All keywords" or "At least one keyword":

All keywords: Photos must include all selected keywords and exclude any
keywords marked for exclusion.
At least one keyword: Photos need to meet only one of the keyword conditions.

Excluding Keywords from Search

Keywords can be excluded from the search using the "minus" symbol next to them. If a
photo contains an excluded keyword, it will no longer appear in the search results.

This makes it easy to quickly find photos related to specific themes or content—and you
might be surprised by what your photo archive holds!

In the search options, as with all searches, you can specify whether the search applies to
the entire database, the current view, or specific folders and collections.





Find faces

The search for faces is called up using the "Find faces" button. In the search dialog you
can select different criteria in levels - the number of faces in the photo, the age of the
persons, whether the persons should be male or female, the eyes should be open or
closed and whether they should smile or not. If these properties are not important in the
search, you can leave them disabled.





Find similar photos

To search for similar photos, you must first select a photo as a template. Then you can
call the search dialog via the button "find similar photos".

Among the search options, the distinction between two types of similarity search is
important:

1. content (searches for photos with similar content).

2. color (here the similarity is determined by the color distribution in the image)

Furthermore, the similarity limit can be set from strict to loose in values from 1 to 100,
which leads to different search results.







Find by GPS

After clicking the "Find by GPS" button, a selection dialog box opens in which you can
enter the starting position of your search.

For this purpose, you can enter the GPS coordinates, specify a location via the list
selection or mark a point on the map.

In addition, you select a radius as a radius for the search and specify whether the search
should be performed over the entire database or only a subset of the photos. The
maximum number of results can also be limited.

Using the "+" and "-" buttons in the map view, you can zoom in and out as desired. By
keeping the mouse button pressed, you can move the map section.





Explore photos in the Map View

Click the corresponding button in the bottom bar to access the map view. It provides a

geographical overview of all photos in the database that have GPS coordinates associated

with them, and is particularly useful for discovering photos from specific regions or trips.

Photos are displayed on the map as black circles, each indicating the number of photos in

that region. As you zoom in, the circles are further subdivided, and the geographic

distribution becomes increasingly detailed. If a circle contains only a single photo, it is

displayed as a thumbnail directly within the circle.

If you click on a circle containing multiple photos, it is highlighted in blue, and a filmstrip

appears at the bottom of the screen showing all photos associated with the selected area.

Note: The map view requires that GPS coordinates have been assigned to the photos. How

to add or transfer GPS data to photos is described in the sections “GPS Data” and “Transfer

GPS Data from One Photo to Another.”





Advanced evaluations with Excire Analytics

With the the extension Excire Analytics, detailed analyses of the photo inventory can be
performed based on the metadata.

Examples would be:

with which camera or lens you have taken the most photos
what your favorite subjects are and what you use to photograph them best
with which settings or which camera-lens-combination you have taken your best
rated pictures
which lens is particularly suitable for which motifs, e.g. portraits
which lenses you should take with you on your trip and what you can safely leave
at home
in which photo genre you are particularly good
up to which exposure time your telephoto still takes good pictures
which camera or lenses you hardly use at all and therefore could sell

Excire Analytics is an integral part of Excire Foto 2024 and does not have to be
purchased separately (as in previous versions).

There is separate documentation on how Excire Analytics works, which can be
downloaded here:

https://shop.excire.com/downloads/excire-foto/ExcireAnalytics.pdf

https://shop.excire.com/downloads/excire-foto/ExcireAnalytics.pdf


Collections and slideshow

Photos can be arranged in collections and displayed on the screen in the form of a slide
show.

To do this, you assign any photos from different folders to a collection.

A collection contains only a reference to a photo, not an independent copy of the photo.
This way, photos can be assigned to multiple collections without storing additional files
on the hard disk.

If you also want to physically store the photos of a collection in a shared folder on your
hard disk, this is possible by right-clicking on the export function.

To create a collection, click on the plus button under Collections. Alternatively, it is also
possible to create groups to which several collections can be assigned. This way you
can arrange your collections in two levels to have a better overview.

The arrangement of groups and collections can also be changed later by drag & drop
with the mouse.

A collection can be opened as a slide show by right-clicking and played on the screen.



Slideshow settings

By right-clicking on a collection, you can set the title of a slideshow and open the start
screen of the slideshow.

However, there are other settings for the slideshow that can be found in the program
settings.

These can be set via the menu Excire Foto -> Preferences and there in the tab
"Slideshow".

The start screen of the slideshow also displays the keyboard shortcut, which can also be
used to access the settings.

In the preferences you can set the display duration of the photos, the duration and type
of transition between photos. The slideshow can also be played in a random order, once
or as a continuous loop.

Finally, the color of the background and the text can be set.

These settings (with the exception of the title) apply across the board to all slideshows,
but can be changed at any time.



Arrange photos manually

Unless the random order of the photos has been activated, the photos are played in the
order in which they are arranged on the screen. The photos can be arranged in any order
by dragging and dropping them with the mouse. This user-specific order remains in the
collection until it is changed again or the sorting in the filter bar is changed to another
criteria.



How to work with "renaming profiles"

To be able to rename many files in one operation, you need to determine how the files
should be named sequentially (and uniquely) beforehand. For this purpose, create a
renaming profile before starting the renaming process.

The filename can be composed of various elements:

1. Basename in the "General" section:
Here, a basic name can be set that will apply to all files, e.g., "Vacation."

2. Numbering in the "Sequence" section:
A sequential numbering can be added to ensure each file has a unique name. For
example, numbering can start at 001 and increase incrementally.

3. Metadata from the capture in the "Metadata" section:
Various metadata, such as the capture date or the camera name, can be included
in the filename.

The order can be freely chosen when creating the renaming profile by dragging and
dropping the elements into the desired sequence with the mouse.

Once the profile is saved, it can be selected during the import, export, or batch renaming
of files.

Example:

If the profile is set so that the filename consists of the base name "Vacation" with the
suffix "2024," followed by numbering and the capture date, the filename could look like
this: "Vacation-2024_001_20240615.jpg."

This way, photos from a family vacation can be quickly and efficiently renamed to allow
for better sorting.









Exporting photos and videos

Several photos can be selected with the mouse and entire collections or folders can be
exported by right-clicking. New files are created and saved in a shared directory. Various
settings can be made during export:

Export path:

The location where the photos are to be exported can be specified. This can be a
location on the local hard drive, an external hard drive or a cloud integrated into the
operating system, such as OneDrive.

Photo format:

You can choose between JPG, PNG, or the original format of the images for export.
Depending on the selected format, additional options for specifying export settings may
be available.

Additionally, the database’s preview images can be used for export. This allows for
exporting in lower resolution even if the original images are not accessible, for instance,
when an external hard drive is not connected.

Rename photos:

A created renaming profile (File -> Renaming profiles) can be applied to the photos.

Metadata:

To retain newly created and edited metadata in the exported photos, this option should
be selected.

Embedded previews:

If available, embedded previews can also be exported.

Maximum dimension:

An upper limit can be set for the dimension of the photos, whereby the image ratio
remains the same. Smaller photos are not enlarged.

JPG quality:

If the JPG format is selected, the compression rate can be adjusted. 

Export videos:



If this option is checked, video files will also be exported to the destination folder. The
original format is always preserved.







Export photos to cloud storage

Excire Foto lets you export photos directly from the program to cloud storage. It supports
Dropbox, Google Drive, OneDrive, and Nextcloud.

Set up a connection

Before you can use this feature, you must link the desired service in the app settings. To do

this, open the Excire Foto menu -> Settings and go to the "Sharing" tab. There, click

"Connect" next to the desired service and follow the instructions to sign in.

Share Photos

Once set up, you can export folders or collections to cloud storage by right-clicking on them.

In the context menu, select "Share" and then choose the desired service. The photos

contained within will then be copied to the linked cloud storage.





Workflow examples

Common use cases from our users include:

Navigating through the photo collection based on content.

With the automatically assigned keywords, one can navigate through the photo
collection based on content, finding many old treasures and awakening beautiful
memories. This often directly generates new ideas for creative photo projects.

Find and delete duplicates

Find duplicates is one of the most popular features in Excire Foto. Duplicate photos can
be easily found in the archive and the unnecessary versions can be deleted. Editing
variants or almost identical images from series shots can also be selected and deleted.
This creates space and order on the hard drives.

Add automatic keywords and create your own keyword hierarchy

After automatic keywording by the artificial intelligence in Excire Foto, it is much more
fun to dive deeper into the photo collection and add your own keywords to the AI
keywords. After all, the AI can't know what the occasion was for a particular group
photo. 

Searching for people and assigning names

Which leads directly to the next common use case: Finding people in the photos and
assigning names. Since Find People in Excire Foto works on the basis of an example
photo, many users proceed by searching for a person with an example and then tagging
all found photos with the person's name as a keyword. This way, people can be easily
retrieved later using the keyword search.

Select and rate images after vacation

With the help of the quick image viewer, you can easily view your photos in Excire Foto
after your vacation and rate the best pictures with a star mark, while unsuccessful
snapshots can be deleted directly from the hard disk again. To select a photo, first click
on the folder with the vacation pictures and then double-click on the first photo to start
viewing. With the arrow key you can easily switch to the next picture or quickly switch
between two pictures for comparison. The number keys 1-5 assign star ratings (0
deletes them again).

Create photo books and family albums

Often, occasion-related collections are also created using the search functions in Excire



Foto.

For example, you can create a collection for a family member's birthday album or your
daughter's wedding album, and then gradually fill this collection using various searches.
Search results can be easily assigned to an existing collection by right-clicking. In the
end, the photos can be exported to a shared folder for easy photo book creation.

For this task, GPS search can be used well, too, when it comes to finding photos from a
certain region and retracing a travel route. Or to document the changes of a place over
the years that one has visited again and again.

Search and export photos for social media

The export function can also be used to output the best photos, which you have selected
with the help of the search functions and the star filters, for use in a web gallery or on
social media in a smaller resolution. To do this, simply specify the desired image
resolution when exporting and output the photo in the selected directory for this type of
photos (e.g. "Photos for Facebook"). 



Open photos in an image editing program

To edit a photo in another program after selecting it in Excire Foto, it can be transferred
to any image editing program installed on your computer.

There are various options for this.

Open with...

By right-clicking on an individual photo, an external program for image or video editing
can be called up via the menu item "Open with...".

A list of all installed programs that are suitable for the respective file type will appear.
Select the desired program here to open the photo directly from Excire Foto.

This is particularly useful if you want to edit your images in Adobe Photoshop, Affinity
Photo or another specialized tool, for example.

The function is also available for video files so that you can open them with an
appropriate video player if required.

By drag & drop

You can also drag and drop photos into an image editing program using the mouse,
provided the other application also supports this.

While "Open with..." only supports one image at a time, you can drag and drop up to 10
files simultaneously from Excire Foto to another application. Please hold down the CTRL
key (or CMD key on Mac) before dragging the images with the mouse.

By transferring ratings or color labels

Some image editing programs do not offer the option of opening a specific image file for
editing, as they only include entire folders in their database. These include popular
programs such as Adobe Lightroom and Capture One. If you try to transfer a photo via
"Open with...", only the import dialog of the corresponding program opens and the
individual photo is ignored. In this case, there is another way to select photos for editing.

To do this, select the desired images in Excire Foto and mark them with a star rating or a
color marker. These markings can be written as metadata in the image files or in XMP
sidecar files and are therefore also visible in programs such as Lightroom or Capture
One. Make sure to save the metadata via the "Save metadata" menu after marking.

The Accept flag, on the other hand, is not written to the metadata as it is not part of a
recognized metadata standard and is not adopted by Excire Foto in XMP files.



After saving the metadata, you can use the Export menu to copy the selected images to
a new directory, which can then be imported into the desired editing program.
Alternatively, this directory can also be used as a so-called "watch folder" to enable an
automated import.



Tips for Finding People and Assigning Names

Below are some advanced tips for finding faces and assigning names, which will help
you work more efficiently with larger image collections.

Finding photos of a specific person who hasn’t been
assigned a name yet

1. Select a photo where the person is clearly visible. Start a people search using this
photo with the following settings:

a. Face selected
b. Under "Filter by Keywords," select the person’s name and click on “Use

photos without these keywords” to enable exclusion of this keyword.

Next steps



To assign the name to these photos, first remove any photos where the person was
incorrectly identified. Then select the remaining images in the view (keyboard shortcut
CTRL + A or CMD + A on Mac) and enter the name in the right-hand column under
the Faces tab.

Finding photos of any people who haven’t been assigned a
name yet

1. Use the face search (not the person search) to find "any faces." This will return images
of people in general. Make sure the maximum number of search results is set high
enough.



2. Now use the keyword search only for the current view. Exclude the names already
present in your database from the search.



Next steps

To assign a name, select a face and follow the steps above to assign a name to all
photos of a specific person.



Frequently Asked Questions (FAQ)

We receive many support questions about Excire Foto every day. We have therefore
published the answers to the most frequently asked questions in our help center:

https://support.excire.com/portal/en/kb/excire

You can also create a support ticket from there if you do not find the answer you are
looking for.

https://support.excire.com/portal/en/kb/excire


Support

How to contact our support in different ways you can find in this article:

https://support.excire.com/portal/en/kb/articles/how-can-i-contact-customer-support

In order to be able to analyze technical problems, it is helpful for us if you use the "Send
error report..." function from the help menu, because this way we also receive the
technical log files from the program.

https://support.excire.com/portal/en/kb/articles/how-can-i-contact-customer-support
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